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Chapter 197 

Superiority by a 
Margin Tests for the 
Odds Ratio of Two 
Proportions 
Introduction 
This module provides power analysis and sample size calculation for superiority by a margin tests of the odds 
ratio in two-sample designs in which the outcome is binary. Users may choose between two popular test statistics 
commonly used for running the hypothesis test.  

The power calculations assume that independent, random samples are drawn from two populations.  

Example 
A superiority by a margin test example will set the stage for the discussion of the terminology that follows. 
Suppose that the current treatment for a disease works 70% of the time. A promising new treatment has been 
developed to the point where it can be tested. The researchers wish to show that the new treatment is better than 
the current treatment by at least some amount. In other words, does a clinically significant higher number of 
treated subjects respond to the new treatment?  

Clinicians want to demonstrate the new treatment is superior to the current treatment. They must determine, 
however, how much more effective the new treatment must be to be adopted. Should it be adopted if 71% 
respond? 72%? 75%? 80%? There is a percentage above 70% at which the difference between the two treatments 
is no longer considered ignorable. After thoughtful discussion with several clinicians, it was decided that if the 
odds ratio of new treatment to reference is at least 1.1, the new treatment would be adopted. This ratio is called 
the margin of superiority. The margin of superiority in this example is 1.1.  

The developers must design an experiment to test the hypothesis that the odds ratio of the new treatment to the 
reference is at least 1.1. The statistical hypothesis to be tested is 

𝐻𝐻0: 𝑂𝑂1 𝑂𝑂2⁄ ≤ 1.1   versus   𝐻𝐻1:𝑂𝑂1 𝑂𝑂2⁄ > 1.1 

Notice that when the null hypothesis is rejected, the conclusion is that the odds ratio is at least 1.1. Note that even 
though the response rate of the current treatment is 0.70, the hypothesis test is about an odds ratio of 1.1. Also 
notice that a rejection of the null hypothesis results in the conclusion of interest.  
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Technical Details  
The details of sample size calculation for the two-sample design for binary outcomes are presented in the chapter 
“Tests for Two Proportions,” and they will not be duplicated here. Instead, this chapter only discusses those 
changes necessary for superiority by a margin tests. 

This procedure has the capability for calculating power based on large sample (normal approximation) results and 
based on the enumeration of all possible values in the binomial distribution.  

Suppose you have two populations from which dichotomous (binary) responses will be recorded. Assume without 
loss of generality that the higher proportions are better. The probability (or risk) of cure in population 1 (the 
treatment group) is  and in population 2 (the reference group) is . Random samples of and individuals 
are obtained from these two populations. The data from these samples can be displayed in a 2-by-2 contingency 
table as follows 
 

Group Success Failure Total 
Treatment    
Control    
Totals   N 
 

The binomial proportions,  and , are estimated from these data using the formulae 

 and  

Define 𝑂𝑂𝑖𝑖 =  𝑝𝑝𝑖𝑖 (1 − 𝑝𝑝𝑖𝑖 )⁄ . Let p1 0.  represent the group 1 proportion tested by the null hypothesis, H0 . The power 
of a test is computed at a specific value of the proportion which we will call p11. . Let 𝜓𝜓0  represent the smallest 
odds ratio (margin of superiority) between the two proportions that still results in the conclusion that the new 
treatment is superior to the current treatment. For a superiority by a margin test, 𝜓𝜓0 > 1 The set of statistical 
hypotheses that are tested is 

𝐻𝐻0: 𝑂𝑂1 𝑂𝑂2⁄ ≤ 𝜓𝜓0    versus   𝐻𝐻1:𝑂𝑂1 𝑂𝑂2⁄ > 𝜓𝜓0  

which can be rearranged to give 

𝐻𝐻0: 𝑂𝑂1 ≤ 𝑂𝑂2𝜓𝜓0    versus   𝐻𝐻1:𝑂𝑂1 > 𝑂𝑂2𝜓𝜓0  

There are three common methods of specifying the margin of superiority. The most direct is to simply give values 
for p2  and p1 0. . However, it is often more meaningful to give p2  and then specify p1 0.  implicitly by specifying 
the difference, ratio, or odds ratio. Mathematically, the definitions of these parameterizations are  
 

Parameter Computation Hypotheses 
Difference  𝛿𝛿0 = 𝑝𝑝1.0 − 𝑝𝑝2  𝐻𝐻0: 𝑝𝑝1 − 𝑝𝑝2 ≤ 𝛿𝛿0    versus   𝐻𝐻1: 𝑝𝑝1 − 𝑝𝑝2 > 𝛿𝛿0  

Ratio 𝜙𝜙0 = 𝑝𝑝1.0 𝑝𝑝2⁄  𝐻𝐻0: 𝑝𝑝1 𝑝𝑝2⁄ ≤ 𝜙𝜙0    versus   𝐻𝐻1:𝑝𝑝1 𝑝𝑝2⁄ > 𝜙𝜙0  

Odds Ratio 𝜓𝜓0 = 𝑂𝑂1.0 𝑂𝑂2⁄  𝐻𝐻0: 𝑂𝑂1 𝑂𝑂2⁄ ≤ 𝜓𝜓0    versus   𝐻𝐻1:𝑂𝑂1 𝑂𝑂2⁄ > 𝜓𝜓0  
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Odds Ratio 
The odds ratio, 𝜓𝜓 = 𝑂𝑂1 𝑂𝑂2⁄ = (𝑝𝑝1 (1 − 𝑝𝑝1)⁄ ) (𝑝𝑝2 (1 − 𝑝𝑝2)⁄ )⁄ , gives the relative change in the odds of the 
response. Testing superiority by a margin uses the formulation  

𝐻𝐻0: 𝑂𝑂1 𝑂𝑂2⁄ ≤ 𝜓𝜓0    versus   𝐻𝐻1:𝑂𝑂1 𝑂𝑂2⁄ > 𝜓𝜓0  

or equivalently 

𝐻𝐻0: 𝜓𝜓 ≤ 𝜓𝜓0    versus   𝐻𝐻1: 𝜓𝜓 > 𝜓𝜓0 . 

For superiority by a margin tests with higher proportions better, 𝜓𝜓0 > 1. For superiority by a margin tests with 
higher proportions worse, 𝜓𝜓0 < 1.  

A Note on Setting the Significance Level, Alpha 
Setting the significance level has always been somewhat arbitrary. For planning purposes, the standard has 
become to set alpha to 0.05 for two-sided tests. Almost universally, when someone states that a result is 
statistically significant, they mean statistically significant at the 0.05 level.  

Although 0.05 may be the standard for two-sided tests, it is not always the standard for one-sided tests, such as 
superiority by a margin tests. Statisticians often recommend that the alpha level for one-sided tests be set at 0.025 
since this is the amount put in each tail of a two-sided test. 

Power Calculation 
The power for a test statistic that is based on the normal approximation can be computed exactly using two 
binomial distributions. The following steps are taken to compute the power of these tests.  

1.  Find the critical value using the standard normal distribution. The critical value, zcritical , is that value of z 
that leaves exactly the target value of alpha in the appropriate tail of the normal distribution.  

2.  Compute the value of the test statistic, zt , for every combination of x11  and x21 . Note that x11  ranges from 
0 to n1 , and x21  ranges from 0 to n2 . A small value (around 0.0001) can be added to the zero-cell counts to 
avoid numerical problems that occur when the cell value is zero. 

3. If z zt critical> , the combination is in the rejection region. Call all combinations of x11  and x21  that lead to a 
rejection the set A. 

4. Compute the power for given values of 𝑝𝑝1.1 and 𝑝𝑝2  as 

1 − 𝛽𝛽 = ��𝑛𝑛1𝑥𝑥11
�𝑝𝑝1.1

𝑥𝑥11𝑞𝑞1.1
𝑛𝑛1−𝑥𝑥11 � 𝑛𝑛2𝑥𝑥21

�𝑝𝑝2
𝑥𝑥21𝑞𝑞2

𝑛𝑛2−𝑥𝑥21

𝐴𝐴

. 

5. Compute the actual value of alpha achieved by the design by substituting 𝑝𝑝1.0 for 𝑝𝑝1.1 to obtain  

𝛼𝛼∗ = ��𝑛𝑛1𝑥𝑥11
�𝑝𝑝1.0

𝑥𝑥11𝑞𝑞1.0
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�𝑝𝑝2
𝑥𝑥21𝑞𝑞2
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𝐴𝐴

. 

Asymptotic Approximations 
When the values of n1  and n2  are large (say over 200), these formulas often take a long time to evaluate. In this 
case, a large sample approximation can be used. The large sample approximation is made by replacing the values 
of p1 and p2  in the z statistic with the corresponding values of p11.  and p2 , and then computing the results based 
on the normal distribution. 

http://www.ncss.com/


PASS Sample Size Software NCSS.com   
Superiority by a Margin Tests for the Odds Ratio of Two Proportions 

197-4 
 © NCSS, LLC. All Rights Reserved. 

Test Statistics 
Two test statistics have been proposed for testing whether the odds ratio is different from a specified value. The 
main difference between the test statistics is in the formula used to compute the standard error used in the 
denominator. These tests are both 

In power calculations, the values of p1 and p2  are not known. The corresponding values of p11.  and p2  may be 
reasonable substitutes. 

Following is a list of the test statistics available in PASS. The availability of several test statistics begs the 
question of which test statistic one should use. The answer is simple: one should use the test statistic that will be 
used to analyze the data. You may choose a method because it is a standard in your industry, because it seems to 
have better statistical properties, or because your statistical package calculates it. Whatever your reasons for 
selecting a certain test statistic, you should use the same test statistic when doing the analysis after the data have 
been collected. 

Miettinen and Nurminen’s Likelihood Score Test 
Miettinen and Nurminen (1985) proposed a test statistic for testing whether the odds ratio is equal to a specified 
value, . Because the approach they used with the difference and ratio does not easily extend to the odds ratio, 
they used a score statistic approach for the odds ratio. The regular MLE’s are  and . The constrained MLE’s 
are  and . These estimates are constrained so that . A correction factor of N/(N-1) is applied to 
make the variance estimate less biased. The significance level of the test statistic is based on the asymptotic 
normality of the score statistic.  

The formula for computing the test statistic is 
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Farrington and Manning’s Likelihood Score Test 
Farrington and Manning (1990) indicate that the Miettinen and Nurminen statistic may be modified by removing 
the factor N/(N-1). 

The formula for computing this test statistic is 
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where the estimates  and  are computed as in the corresponding test of Miettinen and Nurminen (1985) 
given above. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains the parameters associated with this test such as the proportions, odds ratios, sample sizes, 
alpha, and power.  

Solve For 

Solve For 
This option specifies the parameter to be solved for using the other parameters. The parameters that may be 
selected are Power, Sample Size, and Effect Size.  

Select Power when you want to calculate the power of an experiment.  

Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level. 

Power Calculation 

Power Calculation Method 
Select the method to be used to calculate power. When the sample sizes are reasonably large (i.e. greater than 50) 
and the proportions are between 0.2 and 0.8 the two methods will give similar results. For smaller sample sizes 
and more extreme proportions (less than 0.2 or greater than 0.8), the normal approximation is not as accurate so 
the binomial calculations may be more appropriate. 

The choices are 

• Binomial Enumeration 
Power for each test is computed using binomial enumeration of all possible outcomes when N1 and N2 ≤ 
Maximum N1 or N2 for Binomial Enumeration (otherwise, the normal approximation is used). Binomial 
enumeration of all outcomes is possible because of the discrete nature of the data. 

  

~p1
~p2
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• Normal Approximation 
Approximate power for each test is computed using the normal approximation to the binomial distribution. 

Actual alpha values are only computed when “Binomial Enumeration” is selected. 

Power Calculation – Binomial Enumeration 
Options 
Only shown when Power Calculation Method = “Binomial Enumeration” 

Maximum N1 or N2 for Binomial Enumeration 
When both N1 and N2 are less than or equal to this amount, power calculations using the binomial distribution are 
made. The value of the “Actual Alpha” is only calculated when binomial power calculations are made. 
 
When either N1 or N2 is larger than this amount, the normal approximation to the binomial is used for power 
calculations. 

Zero Count Adjustment Method 
Zero cell counts cause many calculation problems when enumerating binomial probabilities. To compensate for 
this, a small value (called the “Zero Count Adjustment Value”) may be added either to all cells or to all cells with 
zero counts. This option specifies which type of adjustment you want to use. 

Adding a small value is controversial, but may be necessary. Some statisticians recommend adding 0.5 while 
others recommend 0.25. We have found that adding values as small as 0.0001 seems to work well. 

Zero Count Adjustment Value 
Zero cell counts cause many calculation problems when enumerating binomial probabilities. To compensate for 
this, a small value may be added either to all cells or to all zero cells. This is the amount that is added. We have 
found that 0.0001 works well. 

Be warned that the value of the odds ratio will be affected by the amount specified here! 

Test 

Higher Proportions Are 
Use this option to specify the direction of the test. Note that OR = O1/O2. 

If Higher Proportions are “Better”, the alternative hypothesis is H1: OR > OR0. 

If Higher Proportions are “Worse”, the alternative hypothesis is H1: OR < OR0. 

Test Type 
Specify which test statistic is used in searching and reporting.  

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.  
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Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that 
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents 
the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size (When Solving for Sample Size) 

Group Allocation 
Select the option that describes the constraints on N1 or N2 or both. 

The options are 

• Equal (N1 = N2) 
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both 
sample sizes at once, no additional sample size parameters need to be entered. 

• Enter N1, solve for N2 
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note 
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power. 

• Enter N2, solve for N1 
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note 
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power. 

• Enter R = N2/N1, solve for N1 and N2 
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2, 
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is  

N2 = R * N1. 

• Enter percentage in Group 1, solve for N1 and N2 
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS 
determines the needed N1 and N2 with this percentage to obtain the desired power. 

N1 (Sample Size, Group 1) 
This option is displayed if Group Allocation = “Enter N1, solve for N2” 

N1 is the number of items or individuals sampled from the Group 1 population.  

N1 must be ≥ 2. You can enter a single value or a series of values. 

N2 (Sample Size, Group 2) 
This option is displayed if Group Allocation = “Enter N2, solve for N1” 

N2 is the number of items or individuals sampled from the Group 2 population. 

N2 must be ≥ 2. You can enter a single value or a series of values. 
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R (Group Sample Size Ratio) 
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.” 

R is the ratio of N2 to N1. That is, 

R = N2 / N1. 

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this 
ratio are considered. 

N2 is related to N1 by the formula: 

N2 = [R × N1], 

where the value [Y] is the next integer ≥ Y. 

For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 = 
10 and N2 = 20, or N1 = 50 and N2 = 100). 

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can 
enter a single or a series of values. 

Percent in Group 1 
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.” 

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2. 
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified 
percentage may occur due to the discrete nature of sample sizes. 

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values. 

Sample Size (When Not Solving for Sample Size) 

Group Allocation 
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2. 

The options are 

• Equal (N1 = N2) 
This selection is used when you wish to have equal sample sizes in each group. A single per group sample 
size will be entered. 

• Enter N1 and N2 individually 
This choice permits you to enter different values for N1 and N2. 

• Enter N1 and R, where N2 = R * N1 
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1. 

• Enter total sample size and percentage in Group 1 
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N, 
and then N2 as N - N1.  
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Sample Size Per Group 
This option is displayed only if Group Allocation = “Equal (N1 = N2).” 

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value 
for N2. 

The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values. 

N1 (Sample Size, Group 1) 
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 = 
R * N1.” 

N1 is the number of items or individuals sampled from the Group 1 population.  

N1 must be ≥ 2. You can enter a single value or a series of values. 

N2 (Sample Size, Group 2) 
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.” 

N2 is the number of items or individuals sampled from the Group 2 population. 

N2 must be ≥ 2. You can enter a single value or a series of values. 

R (Group Sample Size Ratio) 
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.” 

R is the ratio of N2 to N1. That is, 

R = N2/N1 

Use this value to obtain N2 as a multiple (or proportion) of N1. 

N2 is calculated from N1 using the formula: 

N2=[R x N1], 

where the value [Y] is the next integer ≥ Y. 

For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1. 

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can 
enter a single value or a series of values. 

Total Sample Size (N) 
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.” 

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of 
the total sample size in Group 1, implicitly defines N1 and N2. 

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample 
size needs to be at least 2. 

You can enter a single value or a series of values. 

Percent in Group 1 
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.” 

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified 
percentage may occur due to the discrete nature of sample sizes. 

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of 
values. 
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Effect Size – Odds Ratios 

OR0 (Superiority Odds Ratio) 
This option specifies the trivial odds ratio between P1 and P2. The power calculations assume that P1.0 is the 
value of the P1 under the null hypothesis. OR0 is used with P2 to calculate the value of P1.0.  

When Higher Proportions Are is set to Better, the trivial odds ratio implicitly gives the amount by which P1 must 
be greater than P2 to have the treatment group declared superior to the reference group. OR0 should be greater 
than one for superiority by a margin tests. The reverse is the case when Higher Proportions Are is set to Worse.  

Odds ratios must be positive. OR0 cannot take on the value of 1. 

You may enter a range of values such as 0.95 0.97 0.99 or 0.91 to 0.99 by 0.02.  

OR1 (Actual Odds Ratio) 
This option specifies the odds ratio of P1 and P2, where P1.1 is the actual proportion in the treatment group. The 
power calculations assume that P1.1 is the actual value of the proportion in group 1. This value is used with P2 to 
calculate the value of P1.1. 

Odds ratios must be positive. You may enter a range of values such as 0.95 1 1.05 or 0.9 to 1 by 0.02.  

Effect Size – Group 2 (Reference) 

P2 (Reference Group Proportion) 
Specify the value of p2 , the reference, baseline, or control group’s proportion. The null hypothesis is that the two 
proportions differ by no more than a specified amount. Since P2 is a proportion, these values must be between 0 
and 1. 

You may enter a range of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1. 
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Example 1 – Finding Power 
A study is being designed to establish the superiority of a new treatment compared to the current treatment. 
Historically, the current treatment has enjoyed a 62.5% cure rate. The new treatment is hoped to perform better 
than the current treatment. Thus, the new treatment will be adopted if it is more effective than the current 
treatment by a clinically significant amount. The researchers will recommend adoption of the odds ratio of the 
new treatment to the old treatment is at least 1.5.  

The researchers plan to use the Farrington and Manning likelihood score test statistic to analyze the data that will 
be (or has been) obtained. They want to study the power of the Farrington and Manning test at group sample sizes 
ranging from 50 to 500 when the actual odds ratio is 2.0. The significance level will be 0.05. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Superiority by a Margin Tests for the Odds Ratio of Two Proportions procedure window 
by expanding Proportions, then Two Independent Proportions, then clicking on Superiority by a Margin, and 
then clicking on Superiority by a Margin Tests for the Odds Ratio of Two Proportions. You may then make 
the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For .............................................Power 
Power Calculation Method .....................Normal Approximation 
Higher Proportions Are..........................Better (H1: OR > OR0) 
Test Type .............................................Likelihood Score (Farr. & Mann.) 
Alpha ...................................................0.05 
Group Allocation ...................................Equal (N1 = N2) 
Sample Size Per Group .........................50 to 500 by 50 
OR0 (Superiority Odds Ratio) ................1.5 
OR1 (Actual Odds Ratio) .......................2.0 
P2 (Group 2 Proportion) ........................0.625 
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Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Test Statistic:   Farrington & Manning Likelihood Score Test 
Hypotheses:   H0: OR ≤ OR0   vs.   H1: OR > OR0 
 
    Ref. P1|H0 P1|H1 Sup. OR OR   
Power* N1 N2 N P2 P1.0 P1.1 OR0 OR1 Alpha  
0.16278 50 50 100 0.6250 0.7143 0.7692 1.500 2.000 0.050  
0.23613 100 100 200 0.6250 0.7143 0.7692 1.500 2.000 0.050  
0.30292 150 150 300 0.6250 0.7143 0.7692 1.500 2.000 0.050  
0.36502 200 200 400 0.6250 0.7143 0.7692 1.500 2.000 0.050  
0.42291 250 250 500 0.6250 0.7143 0.7692 1.500 2.000 0.050  
0.47676 300 300 600 0.6250 0.7143 0.7692 1.500 2.000 0.050  
0.52669 350 350 700 0.6250 0.7143 0.7692 1.500 2.000 0.050  
0.57279 400 400 800 0.6250 0.7143 0.7692 1.500 2.000 0.050  
0.61522 450 450 900 0.6250 0.7143 0.7692 1.500 2.000 0.050  
0.65413 500 500 1000 0.6250 0.7143 0.7692 1.500 2.000 0.050  
 
* Power was computed using the normal approximation method. 
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Report Definitions 
Power is the probability of rejecting a false null hypothesis. 
N1 and N2 are the number of items sampled from each population. 
N is the total sample size, N1 + N2. 
P2 is the proportion for Group 2, which is the standard, reference, or control group. 
P1 is the proportion for Group 1, which is the treatment or experimental group. P1.0 is the smallest Group 1 
   proportion that still yields a superiority conclusion. P1.1 is the proportion for Group 1 under the 
   alternative hypothesis at which power and sample size calculations are made. 
OR0 is the superiority odds ratio, [P1/(1-P1)] / [P2/(1-P2)], assuming H0. OR1 is the odds ratio under the 
   alternative hypothesis used for power and sample size calculations. 
Alpha is the probability of rejecting a true null hypothesis. 
 
 
Summary Statements ───────────────────────────────────────────────────────── 
Sample sizes of 50 in Group 1 and 50 in Group 2 achieve 16.278% power to detect an odds ratio 
of 2.000 when the superiority odds ratio is 1.500. The reference group proportion is 0.6250. 
The treatment group proportion is assumed to be 0.7143 under the null hypothesis. The power was 
computed for the case when the actual treatment group proportion is 0.7692. The test statistic 
used is the one-sided Score test (Farrington & Manning). The significance level of the test is 
0.050. 
 

This report shows the values of each of the parameters, one scenario per row.  
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Plots Section 
    

  
 

The values from the table are displayed in the above chart. These charts give us a quick look at the sample size 
that will be required for various sample sizes.  
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Example 2 – Finding the Sample Size 
Continuing with the scenario given in Example 1, the researchers want to determine the sample size necessary to 
achieve a power of 0.80.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Superiority by a Margin Tests for the Odds Ratio of Two Proportions procedure window 
by expanding Proportions, then Two Independent Proportions, then clicking on Superiority by a Margin, and 
then clicking on Superiority by a Margin Tests for the Odds Ratio of Two Proportions. You may then make 
the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For .............................................Sample Size 
Power Calculation Method .....................Normal Approximation 
Higher Proportions Are..........................Better (H1: OR > OR0) 
Test Type .............................................Likelihood Score (Farr. & Mann.) 
Power ..................................................0.80 
Alpha ...................................................0.05 
Group Allocation ...................................Equal (N1 = N2) 
OR0 (Superiority Odds Ratio) ................1.5 
OR1 (Actual Odds Ratio) .......................2.0 
P2 (Group 2 Proportion) ........................0.625 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Test Statistic:   Farrington & Manning Likelihood Score Test 
Hypotheses:   H0: OR ≤ OR0   vs.   H1: OR > OR0 
 
Target Actual    Ref. P1|H0 P1|H1 Sup. OR OR   
Power Power* N1 N2 N P2 P1.0 P1.1 OR0 OR1 Alpha  
0.80 0.80002 745 745 1490 0.6250 0.7143 0.7692 1.500 2.000 0.050 
 
* Power was computed using the normal approximation method. 

 

The required sample size is 1035 per group.  
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Example 3 – Comparing the Power of the Two Test Statistics 
Continuing with Example 2, the researchers want to determine which of the two possible test statistics to adopt by 
using the comparative reports and charts that PASS produces. They decide to compare the powers from binomial 
enumeration and actual alphas for various sample sizes between 1000 and 1200. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Superiority by a Margin Tests for the Odds Ratio of Two Proportions procedure window 
by expanding Proportions, then Two Independent Proportions, then clicking on Superiority by a Margin, and 
then clicking on Superiority by a Margin Tests for the Odds Ratio of Two Proportions. You may then make 
the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For .........................................................Power 
Power Calculation Method .................................Binomial Enumeration 
Maximum N1 or N2 for Binomial Enumeration .....5000 
Zero Count Adjustment Method ..........................Add to zero cells only 
Zero Count Adjustment Value ............................0.0001 
Higher Proportions Are......................................Better (H1: OR > OR0) 
Test Type .........................................................Likelihood Score (Farr. & Mann.) 
Alpha ...............................................................0.05 
Group Allocation ...............................................Equal (N1 = N2) 
Sample Size Per Group .....................................600 700 800 
OR0 (Superiority Odds Ratio) ............................1.5 
OR1 (Actual Odds Ratio) ...................................2.0 
P2 (Group 2 Proportion) ....................................0.625 

Reports Tab 
Show Comparative Reports ...............................Checked 

Comparative Plots Tab 
Show Comparative Plots....................................Checked 
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Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 

Power Comparison of Two Different Tests ─────────────────────────────────────────── 
Hypotheses:   H0: OR ≤ OR0   vs.   H1: OR > OR0 
 
    F.M. M.N. 
   Target Score Score 
N1/N2 P2 P1.1 Alpha Power Power 
600/600 0.6250 0.7692 0.0500 0.7297 0.7297 
700/700 0.6250 0.7692 0.0500 0.7862 0.7862 
800/800 0.6250 0.7692 0.0500 0.8322 0.8313 
 
Note: Power was computed using binomial enumeration of all possible outcomes. 
 
Actual Alpha Comparison of Two Different Tests ─────────────────────────────────────── 
Hypotheses:   H0: OR ≤ OR0   vs.   H1: OR > OR0 
 
    F.M. M.N. 
   Target Score Score 
N1/N2 P2 P1.1 Alpha Alpha Alpha 
600/600 0.6250 0.7692 0.0500 0.0503 0.0503 
700/700 0.6250 0.7692 0.0500 0.0502 0.0502 
800/800 0.6250 0.7692 0.0500 0.0502 0.0501 
 
Note: Actual alpha was computed using binomial enumeration of all possible outcomes. 
 

 
 

The power is almost exactly the same for both tests, which is not surprising given the large sample size. 

http://www.ncss.com/


PASS Sample Size Software NCSS.com   
Superiority by a Margin Tests for the Odds Ratio of Two Proportions 

197-17 
 © NCSS, LLC. All Rights Reserved. 

Example 4 – Comparing Power Calculation Methods 
Continuing with Example 3, let’s see how the results compare if we were to use approximate power calculations 
instead of power calculations based on binomial enumeration. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Superiority by a Margin Tests for the Odds Ratio of Two Proportions procedure window 
by expanding Proportions, then Two Independent Proportions, then clicking on Superiority by a Margin, and 
then clicking on Superiority by a Margin Tests for the Odds Ratio of Two Proportions. You may then make 
the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For .............................................Power 
Power Calculation Method .....................Normal Approximation 
Higher Proportions Are..........................Better (H1: OR > OR0) 
Test Type .............................................Likelihood Score (Farr. & Mann.) 
Alpha ...................................................0.05 
Group Allocation ...................................Equal (N1 = N2) 
Sample Size Per Group .........................600 700 800 
OR0 (Superiority Odds Ratio) ................1.5 
OR1 (Actual Odds Ratio) .......................2.0 
P2 (Group 2 Proportion) ........................0.625 
Reports Tab 
Show Power Detail Report .....................Checked 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 

Power Detail Report ────────────────────────────────────────────────────────── 
Test Statistic:   Farrington & Manning Likelihood Score Test 
Hypotheses:   H0: OR ≤ OR0   vs.   H1: OR > OR0 
 
 Normal Approximation Binomial Enumeration 
N1/N2 P2 OR0 OR1 Power Alpha Power Alpha 
600/600 0.6250 1.500 2.000 0.72209 0.050 0.72971 0.050 
700/700 0.6250 1.500 2.000 0.77821 0.050 0.78622 0.050 
800/800 0.6250 1.500 2.000 0.82407 0.050 0.83218 0.050 
 

Notice that the approximate power values are close to the binomial enumeration values for all sample sizes. 
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Example 5 – Validation 
We could not find a validation example for a superiority by a margin test for the odds ratio of two proportions. 
The calculations are basically the same as those for a superiority by a margin test of the ratio of two proportions, 
which has been validated using Blackwelder (1993). We refer you to Example 5 of Chapter 196, “Superiority by a 
Margin Tests for the Ratio of Two Proportions,” for a validation example. 

http://www.ncss.com/

	Introduction
	Example

	Technical Details 
	Odds Ratio
	A Note on Setting the Significance Level, Alpha
	Power Calculation
	Asymptotic Approximations

	Test Statistics
	Miettinen and Nurminen’s Likelihood Score Test
	Farrington and Manning’s Likelihood Score Test


	Procedure Options
	Design Tab
	Solve For
	Solve For

	Power Calculation
	Power Calculation Method

	Power Calculation – Binomial Enumeration Options
	Maximum N1 or N2 for Binomial Enumeration
	Zero Count Adjustment Method
	Zero Count Adjustment Value

	Test
	Higher Proportions Are
	Test Type

	Power and Alpha
	Power
	Alpha

	Sample Size (When Solving for Sample Size)
	Group Allocation
	N1 (Sample Size, Group 1)
	N2 (Sample Size, Group 2)
	R (Group Sample Size Ratio)
	Percent in Group 1

	Sample Size (When Not Solving for Sample Size)
	Group Allocation
	Sample Size Per Group
	N1 (Sample Size, Group 1)
	N2 (Sample Size, Group 2)
	R (Group Sample Size Ratio)
	Total Sample Size (N)
	Percent in Group 1

	Effect Size – Odds Ratios
	OR0 (Superiority Odds Ratio)
	OR1 (Actual Odds Ratio)

	Effect Size – Group 2 (Reference)
	P2 (Reference Group Proportion)



	Example 1 – Finding Power
	Setup
	Annotated Output
	Numeric Results
	Plots Section


	Example 2 – Finding the Sample Size
	Setup
	Output
	Numeric Results


	Example 3 – Comparing the Power of the Two Test Statistics
	Setup
	Output
	Numeric Results and Plots


	Example 4 – Comparing Power Calculation Methods
	Setup
	Output
	Numeric Results and Plots


	Example 5 – Validation
	---
	P197_001
	P197_003
	P197_004
	P197_006
	P197_007


